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1. Velkomst v/Kirsten Ravn Christiansen, MedCom

2. Status på version 0.9 for begge FHIR-standarder v/MedCom

a. Orientering om ændringer fra version 0.9 til dagens møde for begge FHIR-standarder på baggrund af inputs fra Q&A-mødet i november 
2020 v/Kirsten Ravn Christiansen og Jeanette Jensen

b. ’Bordet rundt’ med feedback på version 0.9 for begge FHIR-meddelelser fra deltagerne v/Ole Vilstrup (engelsk)

c. Sammenligning af dataelementer mellem OIOXML og FHIR v/Irene Zuschlag (engelsk)

3. Guidening i indpakning af FHIR-meddelelse i eksisterende VANSEnvelope v/Ole Vilstrup, MedCom (engelsk)

4. Intro til Touchstone v/Anders Jensen, MedCom (engelsk)

a. Demonstration af test for begge FHIR-meddelelser

5. Fra EDI til FHIR v/Michael Johansen

a. Orientering om MedComs FHIR roadmap, med bølger af standarder der foretages EDIfact udfasning for 

b. Migreringsstrategi fra EDIfact til FHIR 

6. Orientering om behov for indsamling af tidsplaner/roadmaps fra leverandører vedr. teknisk udvikling og forventet implementering af 

’CareCommunication’ og ’HospitalNotification’ v/Dorthe Skou Lassen, MedCom (engelsk)

7. Eventuelt v/MedCom

Dagsorden
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Video-mødekultur

• Mute mikrofonen

• Brug chatten

– til kommentarer/spørgsmål
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Mie Borch Dahl Kristensen
Konsulent

mbk@medcom.dk

2499 0054

Kommuneteam Standardteam 

Anders Jensen
Konsulent

anj@medcom.dk

3057 5746

MedCom deltagere

mailto:mbk@medcom.dk
tel:2499%200054
mailto:anj@medcom.dk
tel:3057%205746
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FHIR Ressource:

• Mjølner

EPJ leverandører + brugerrepræsentanter:

• Systematic

• EPIC 

• NOVAX privat hospital 

EOJ leverandører + brugerrepræsentanter:

• KMD Nexus 

• Cura

• DXC Vitae

• EG Sensum

LPS-leverandører:

• NOVAX

• EG

• MultiMed

• CGM XMO

• MyClinic

KOMBIT beskedfordeler/agent:

• KOMBIT

• MultiMed

• KMD

Velkommen til deltagerne



Status på version 0.9 for begge FHIR-standarder 

v/MedCom



Orientering om ændringer fra version 0.9 til 
dagens møde for begge standarder

v/Kirsten Ravn Christiansen og Jeanette Jensen
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FHIR-Korrespondancemeddelelse
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Kort status: ændringer fra 0.9 til 1.0

❖ Trække statistik på afsendte/modtagne FHIR-KM (national 
kategori)

→ Kategori-koderne tilføjes i statistikfeltet i VANS-envelope

❖ Præcisering af afsnit om bilag i Sundhedsfaglige 
anbefalinger

→ Oprindelig forfatter på bilag vs. ansvarlig for 
medsendelse af bilag

❖ Tilføjelse af use case

→ Besvarelse af MedCom-meddelelser med FHIR-KM

Standard: 

CareCommunication

(FDIS91)

Dansk/daglig tale:

FHIR-

Korrespondancemedd

elelse (FHIR-KM)
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Status på FHIR advis om sygehushold 
Fra 0.9 til 1.0 version
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Hvad skal afklares frem mod 1.0 version?

• Håndtering af overflytning mellem regioner 

– Brug af option ”afsluttet til andet end hjemmet/primær sektor”
– Krav omkring overflytning mellem regioner – i proces! (møde* den 4.12) 

• Statistik-tags til VANS envelope vedr. advistyper

– Forretningsmæssige behov vedr. statistik (møde* den 4.12)

– Teknisk håndtering (møde med MedWare møde 9.12)

• Brug af entydig identifier til at binde adviser sammen

– skal det være ”LPR3 identifier”? 

– *i MedCom hjemmepleje-sygehusgruppen

Fra Q & A 

workshop 

den 26. 

nov.

https://www.medcom.dk/opslag/navne-og-adresser?gruppe=Hjemmepleje-sygehusgruppe


12

Håndtering af overflytning mellem regioner

Hjemmepleje-sygehusgruppens møde den 4. dec. 
2020:

• Kun én type SLUT advis: ved afslutning til 
hjemmet/primær sektor [SLHJ]

• Krav fastholdes om at der ikke skal sendes 
”Afsluttet til hjemmet” ved overflytning mellem 
regioner

• Pt. udfordring i Midt EPJ at undlade at sende 
SLUT advis 

• Der arbejdes på en løsning i det vestdanske EPJ-
samarbejde

Dokumentationen tilrettes ift. SLUT advis: 

• Sundhedsfaglige anbefalinger og 
kodeoversigt

• Use case beskrivelser

• FHIR profilering

Dialog med det vestdanske it- samarbejde 
og leverandør om opfyldelse af krav ved 
idriftsættelse
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Statistik tags til VANS envelope

Hjemmepleje-sygehusgruppens møde den 4. 
dec. 2020:

• Afklaring visning af advistyper i MedWare
statistikken 

• Præsenteres således: 

• + Orlov Slut medtages 

Code Provenance.activity Visning i statistikopgørelse

AcuteAmbulant admit-emergency Sygehusadvis_Akut ambulant

AcuteAmbulant revise-admit-emergency Sygehusadvis_Akut ambulant

AcuteAmbulant cancel-admit-emergency Sygehusadvis_Akut ambulant

AdmissionInpatient admit-inpatient Sygehusadvis_Indlagt

AdmissionInpatient revise-admit-inpatient Sygehusadvis_Indlagt

AdmissionInpatient cancel-admit-inpatient Sygehusadvis_Indlagt

OnLeave start-leave-inpatient Sygehusadvis_Orlov

OnLeave revise-start-leave-inpatient Sygehusadvis_Orlov

OnLeave cancel-start-leave-inpatient Sygehusadvis_Orlov

EndOnLeave end-leave-inpatient Sygehusadvis_Orlov_Slut

EndOnLeave revise-end-leave-inpatient Sygehusadvis_Orlov_Slut

EndOnLeave cancel-end-leave-inpatient Sygehusadvis_Orlov_Slut

EndHospitalStay discharge-[Encounter.Class]-home Sygehusadvis_Slut 

EndHospitalStay revise-discharge-[Encounter.Class]-home Sygehusadvis_Slut 

EndHospitalStay cancel-discharge-[Encounter.Class]-home Sygehusadvis_Slut 

EndHospitalStay discharge-[Encounter.Class]-other Sygehusadvis_Slut 

EndHospitalStay revise-discharge-[Encounter.Class]-other Sygehusadvis_Slut

EndHospitalStay cancel-discharge-[Encounter.Class]-other Sygehusadvis_Slut 

EndHospitalStay "any activity" Sygehusadvis_Slut 

EndHospitalStay "any activity" Sygehusadvis_Slut 

EndHospitalStay "any activity" Sygehusadvis_Slut

https://build.fhir.org/ig/hl7dk/dk-medcom/branches/new-care-communication-profile-okt-thaj/CodeSystem-medcom-messaging-activityCodes.html#medcom-messaging-activityCodes-admit-emergency
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Type identifier i FHIR advis  

• Der peges på en ”episode of care” identifier, som unikt binder meddelelser 
sammen, som dannes i EPJ/PAS systemet og som fastholdes i samme 
indlæggelsesforløb i samme region. 

• Der kan suppleres med en anden type identifier, som potentielt kan være en 
LPR3 identifier
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Ny use case vil blive tilføjet 

• Spørgsmål: 

– Hvordan skal advis håndteres, hvis patienten dør under orlov?

• Svar: 

– Der sendes Advis om død, når patienten registreres død i EPJ/PAS

– (Obs Zulip: No message)

• Vil blive tilføjet som use case i 1.0 release. 



’Bordet rundt’ med feedback på version 0.9 for 
begge standarder



”Bordet rundt” – feedback på version 0.9 for begge FHIR-meddelelser

17

EPJ leverandører:

• Systematic + brugerrepræsentanter

• EPIC + brugerrepræsentanter

• (NOVAX privat hospital) 

EOJ leverandører

• KMD Nexus + brugerrepræsentanter

• Cura+ brugerrepræsentanter

• EG Sensum+ brugerrepræsentanter

• DXC Vitae + brugerrepræsentanter

LPS-leverandører: (only CareCommunication)

• NOVAX

• EG

• MultiMed

• CGM XMO

• MyClinic

KOMBIT beskedfordeler: (only HospitalNotification)

• MultiMed

• KMD



OIOXML 

FHIR 

Referencer 

11. januar 2021













Link til OIOXML FHIR referencer

• http://svn.medcom.dk/svn/drafts/Standarder/HL7/FHIR/General%20
documentation/OIOXML%20FHIR%20references.xlsx



FHIR messages in VANSenvelope

/Ole Vilstrup, MedCom 



FHIR messages in VANSenvelope

VANSenvelope contains 3 elements, which are influenced by FHIR as a new 

messagetype. These elements are contained in the element 

”VANSEnvelope/Message/MetaInformation/Document/”. 

These are: 

- Format

- Name

- Version



FHIR messages in VANSenvelope
Format

Format has the same value as  ”Standard type” in MedComs standard catalogue and is defined for all FHIR-standards to ”HL7”.

Name

Name has the same value as ”Type nr.” in MedComs standard catalogue and will therefore vary from messagetype to messagetype. Name is 

prefixed ”MCM:” and will be postfixed with statistical variants of a given messagetype. Known from GGOP this for instance can be GGOP1, GGOP2 

or GGOP3. 

Version

Version has the same value as ”Version” in MedComs standard catalogue and will therefore vary from message version to message version. We

will though move towards a simpler value like ”1.0”



VANSenvelope - HospitalNotification
<?xml version="1.0" encoding="UTF-8"?>
<VANSEnvelope xmlns="urn:oio:medcom:vans-envelope:1.0.4"
xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance"
xsi:schemaLocation="urn:oio:medcom:vans-envelope:1.0.4 file:/C:/Repositories/drafts/VANSEnvelope/VANSEnvelope.xsd">

<SenderID EndPointType="EAN">SenderID0</SenderID>
<ReceiverID EndPointType="EAN">ReceiverID0</ReceiverID>
<EnvelopeIdentifier>00000000-0000-0000-0000-000000000000</EnvelopeIdentifier>
<SentDateTime>2021-01-01T00:00:00.0</SentDateTime>
<Message>

<MetaInformation>
<Identifier>00000000-0000-0000-0000-000000000000</Identifier>
<Document>

<Format>HL7</Format>
<Name>MCM:FDIS20#[<code>]</Name>
<Version>1.0</Version>
<SizeInBytes>0</SizeInBytes>

</Document>
<Transport>

<Type>reliable</Type>
<TransformMessage>false</TransformMessage>

</Transport>
</MetaInformation>
<Data>ZGVmYXVsdA==</Data>

</Message>
</VANSEnvelope>

*[<code>] erstattes af værdier fra næste side



VANSenvelope - HospitalNotification
Code Provenance.activity Visning i statistikopgørelse

AcuteAmbulant admit-emergency Sygehusadvis_Akut ambulant

AcuteAmbulant revise-admit-emergency Sygehusadvis_Akut ambulant

AcuteAmbulant cancel-admit-emergency Sygehusadvis_Akut ambulant

AdmissionInpatient admit-inpatient Sygehusadvis_Indlagt

AdmissionInpatient revise-admit-inpatient Sygehusadvis_Indlagt

AdmissionInpatient cancel-admit-inpatient Sygehusadvis_Indlagt

OnLeave start-leave-inpatient Sygehusadvis_Orlov

OnLeave revise-start-leave-inpatient Sygehusadvis_Orlov

OnLeave cancel-start-leave-inpatient Sygehusadvis_Orlov

EndOnLeave end-leave-inpatient Sygehusadvis_Orlov_Slut

EndOnLeave revise-end-leave-inpatient Sygehusadvis_Orlov_Slut

EndOnLeave cancel-end-leave-inpatient Sygehusadvis_Orlov_Slut

EndHospitalStay discharge-[Encounter.Class]-home Sygehusadvis_Slut 

EndHospitalStay revise-discharge-[Encounter.Class]-home Sygehusadvis_Slut 

EndHospitalStay cancel-discharge-[Encounter.Class]-home Sygehusadvis_Slut 

EndHospitalStay discharge-[Encounter.Class]-other Sygehusadvis_Slut 

EndHospitalStay revise-discharge-[Encounter.Class]-other Sygehusadvis_Slut 

EndHospitalStay cancel-discharge-[Encounter.Class]-other Sygehusadvis_Slut 

EndHospitalStay "any activity" Sygehusadvis_Slut 

EndHospitalStay "any activity" Sygehusadvis_Slut 

EndHospitalStay "any activity" Sygehusadvis_Slut



VANSenvelope - CareCommuncation
<?xml version="1.0" encoding="UTF-8"?>
<VANSEnvelope xmlns="urn:oio:medcom:vans-envelope:1.0.4"
xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance"
xsi:schemaLocation="urn:oio:medcom:vans-envelope:1.0.4 file:/C:/Repositories/drafts/VANSEnvelope/VANSEnvelope.xsd">

<SenderID EndPointType="EAN">SenderID0</SenderID>
<ReceiverID EndPointType="EAN">ReceiverID0</ReceiverID>
<EnvelopeIdentifier>00000000-0000-0000-0000-000000000000</EnvelopeIdentifier>
<SentDateTime>2021-01-01T00:00:00.0</SentDateTime>
<Message>

<MetaInformation>
<Identifier>00000000-0000-0000-0000-000000000000</Identifier>
<Document>

<Format>HL7</Format>
<Name>MCM:FDIS91#[<code>]</Name>
<Version>1.0</Version>
<SizeInBytes>0</SizeInBytes>

</Document>
<Transport>

<Type>reliable</Type>
<TransformMessage>false</TransformMessage>

</Transport>
</MetaInformation>
<Data>ZGVmYXVsdA==</Data>

</Message>
</VANSEnvelope>

*[<code>] erstattes af værdier fra næste side



VANSenvelope - CareCommuncation

Code Display Visning i statistik (dansk)

outpatient Outpatient Ambulant

decease Decease Dødsfald

carecoordination Care Coordination Forløbskoordinering

assistive-devices Assistive Devices Hjælpemidler

medicine Medicine Medicin

psychiatry-social-disability Psychiatry, Social, Disability Psykiatri, social, handicap

alcohol-and-drug-treatment Alcohol and drug treatment Rusmiddelbehandling

healthcare Healthcare Sundhedspleje

nursing Nursing Sygepleje

telemedicine Telemedicine Telemedicin

training Training Træning

discharge Discharge Udskrivelse

regarding-referral Regarding Referral Vedr. henvisning

assessment Assessment Visitation

examination-results Examination Results Undersøgelsessvar

other Other Andet



HospitalNotification - DRAFT

Touchstone 



test scope

25-01-2021 33

-Use cases

-Code/status 

combination

s 



Test Scripts

25-01-2021 34

https://touchstone.aegis.net/touchstone/testdefinitions?selectedTestGrp=/FHIRSand

box/MedCom/FHIR4-0-1&activeOnly=false&contentEntry=TEST_SCRIPTS

https://touchstone.aegis.net/touchstone/testdefinitions?selectedTestGrp=/FHIRSandbox/MedCom/FHIR4-0-1&activeOnly=false&contentEntry=TEST_SCRIPTS


Test Suites

25-01-2021 35

https://touchstone.aegis.net/touchstone/conf

ormance/current?suite=FHIR4-0-1-

Hospitalnotification-sent-Client

https://touchstone.aegis.net/touchstone/conf

ormance/current?suite=FHIR4-0-1-

HospitalNotification-receiving-Client

https://touchstone.aegis.net/touchstone/conformance/current?suite=FHIR4-0-1-Hospitalnotification-sent-Client
https://touchstone.aegis.net/touchstone/conformance/current?suite=FHIR4-0-1-HospitalNotification-receiving-Client


Running Test

25-01-2021 Evt. tekst i sidefod 36



Test - Progress

25-01-2021 Evt. tekst i sidefod 37



Odense d. 11/1-2021

Michael Johansen, chefkonsulent for standardteam

mjo@medcom.dk

Roadmap for 
EDIfact-udfasning

FHIR-meddelelser og
Migreringsstrategi

mailto:mjo@medcom.dk
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Roadmap for EDIfact udfasning

• Valg af omlægningen

1. Teknisk omlægning, kun med minimale ændringer

• Letter en migreringsstrategi med mapning

2. Omlægning inkl. sundhedsfaglig revidering

• Indfri ønskede forretningsmæssige behov

• MedComs roadmap anbefaler et antal bølger

• Bølgens varighed afhænger af omlægningsvalg

• Flere samtidige formater er dyrt, så migrer hurtigt

• Første opgave i MedCom12 er fastlæggelse af bølgelængde

• Ikke alle bølger behøves have samme bølgelængde
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Bølger med samhørende standarder

• Advis og korrespondance

• Henvisning, epikrise/afslutningsnotat

• Lab. rekvisition/svar

• Kommune/sygehus kommunikation

• Afregning (og øvrige standarder)

• Udvekslingsformater

• Opsamling
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Tidsplan for en bølge

• Kan udarbejdelse ske hurtigt?

• Hovedpart af standarder har 

behov for revidering

• Prioritering

• Høring

• Koordinering

• Udarbejdelse tager et år

• Kan implementering kortes

ned fra nuværende 

12-18 måneder?



42

Roadmap for EDIfact udfasning – Roadmap puslespil

• Det tager nok et antal MedCom projektperioder (parallelle udarbejdelser kan konflikte)



Odense d. 11/1-2021

Michael Johansen, chefkonsulent for standardteam

mjo@medcom.dk

FHIR-meddelelser og
Migreringsstrategi

mailto:mjo@medcom.dk
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MedComs implementeringsmodel

• Alle modtagere gør sig klar, i deres tempo

• Derpå skifter afsenderne, i deres tempo

• Udfordringer

• Afsendere må afvente sidste modtager

• Modtager skal understøtte to versioner

indtil sidste afsender har skiftet



45

Klassiske migreringsstrategier

1. Konverteringsløsning, der enten lokalt eller centralt sikrer en oversættelse mellem EDIfact og 

HL7/FHIR. konverteringen besværliggøres markant, hvis der åbnes op for indholdsmæssige 

ændringer i standarderne. 

2. Etablering af en central ”MedCom-online” løsning, hvor samarbejdspartnere på en web-grænseflade 

kan tilgå og igangsætte MedCom kommunikation, indtil FHIR-standarderne er implementeret i eget 

journalsystem.

• Når FHIR-meddelelse ikke kan modtages, læses oplysninger på webgrænsefladen. 

3. Etablering af central opslagsløsning, hvor afsenders journalsystem automatisk kan hente information 

om, hvilket format (EDIfact eller FHIR) den konkrete modtager understøtter, hvorved alle parter i en 

overgangsperiode skal kunne afsende i både EDIfact og FHIR-format, og de enkelte parter successivt 

implementere modtagelse af FHIR-format. 

• Overvejelse om SOR kan anvendes

4. Big Bang 
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1) Mapning

• Dette er løsningen hvor afsender kun kan afsende én version

• Understøtte mapning fra EDIfact til FHIR

• Burde være muligt, skønt kategori ikke sættes optimalt

• Ikke 1:1

• Understøtte mapning fra FHIR til EDIfact

• Burde være muligt, skønt nogle ekstra oplysninger tilføjes i halen på brødtekst

• Ikke 1:1

• Særskilt komplicerende ved vedhæftede bilag (medbin)

• Man kan angive at bilag forefindes, men det er ikke tilgængeligt
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Mapning (ikke 1:1 – som ved EDIfact/OIOXML)

TXT

PDF
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2) Central meddelelsesplatform

• Dette er en løsning hvor afsender skifter til ny version uden hensyntagen til modtagersystem

• Nogle modtagere understøtter ikke ny version

• Her kan man vælge at sende en KM som notifikation

• Modtager må logge på central platform og læse den meddelelse man ikke kan modtage

• Bør man sende en positiv kvittering fra platformen (meddelelse er jo ikke læst)?

Det vil være misvisende at sende en negativ kvittering.

• Nogle afsendere understøtter ikke ny version

• Sender gamle versioner

• Modtagere skal understøtte begge versioner i en overgang (hvor lang er overgang?)

• Central platform skal etableres

• Er det i forbindelse med moderniseret infrastruktur?
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Central platform (modtager der ikke er first-mover)

TXT
”PIP”

TXT
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3) Fordeling ud fra central opslagsværk

• Dette er løsningen hvor afsendersystemer kan sende forskellige version

• Hvilken version modtageren får, fremgår af central register

• SOR-EDI

• SMP fra eDelivery

• Denne løsning pålægger afsender den største udviklingsopgave

• Belønner ikke first-movers
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Fordeling (af afsender)

TXT

TXT
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4) Big Bang

• Meget svært at realisere, fordi alle afsender og modtage skal være enige om én skæringsdato

• Kan anvendes for udvalgte meddelelsestyper

• Typisk et forberedt mini ”Big Bang”
• Modtagersystemerne udvikles over en periode, hvorpå afsenderne skifter ved fælles skæringsdato

• Alle modtagere gør sig i stand til at modtage både gammel og ny version

• Herpå skifter alle afsendere samme dato

• Den gamle version udfases

• Kun anvendelig ved få afsendersystemer og få modtagersystemer
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Drøftelse

1. Mapning

• Tab af data er ikke en mulighed

2. Central meddelelsesplatform

• De røde tråde tabes

• Modtagere skal notificeres

• Moderniseret infrastruktur er ikke klar

3. Fordeling ud fra central register

• Firstmovers straffes

• Afsendere skal understøtte to versioner

• SOR-EDI har mangler og eDelivery er ikke klar

4. Big Bang
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Migreringsforslag

• Mapning (1) for korrespondancemeddelelse

• Firstmovers belønnes

• Etablering af central mappe-service

• Bør langsom afsender få mappet om?

(MedBin -> FHIR KM med bilag)

• Bør langsom modtager få vedhæftede bilag?

• Mappe-service returnere flere meddelelser

• ”Big Bang” (4) for advis om sygehusophold
• Modtagere implementerer over en periode

• Kommer til at understøtte to versioner

• Afsendere skifter herpå samtidigt



Information on the need to collect schedules / roadmaps

from

IT suppliers, regions, municipalities, practice area

relating to

technical development and expected implementation of

‘CareCommunication’ and ‘Hospital-Notification’

Dorthe Skou Lassen, MedCom



From 2021 to 2022-2023

Technical and organizational implementation

Meeting between roadmaps & agreements  

Ready to use the 2 new standards

• xx



MedCom plan + 
release version 
1.0

Compare 
roadmaps 
Organizational 
& technical  
preparations

Schedule for 
certification

Technical 
implementation 
/release 

In operation -
Organizational 
use

Evaluation 

Local agreements & schedules

National implementation plan 

Lots of information to put together = co-decision/collective plan



Data collection for schedule so that implementation can be agreed and determined

Who

Hospital-
Notification

Care 
Communication

Certification

YYYY-MM-DD

Technical 
implementation
YYYY-MM-DD

Organizational use
YYYY-MM-DD

4 EOJ suppliers *

98 municipalities *
x x ? ? ?

7 PLS Medical System 

Lev. * PL forum

3,275 doctors *

x ? ? ?

5 Regions *

Approx. 47 hospitals *
x x ? ? ?

KOMBIT 

message distributor
x ? ? ?

Private hospitals ? x ? ? ?

Private specialists, Pharmacies , 

Dentists, Physiotherapist, 

Chiropractors, Psychologists,  

Podiatrists

x ? ? ?

* Makes up approx. 95% of correspondence messages

Mapping in detail -

what is the need?

Roadmaps

& 

agreements



MedCom status and 

presentations as well as status 

from all parties.

Plan for certification

Release plan / technical impl.

Organizational impl.

Operating date

Input to MedCom's upcoming 

work with next the FHIR 

standards

FHIR standards - preparation 2021

2020
Workshop

January 11th

Video conference

MedCom 

Steering group

March 17

4. FHIR meeting on the 

FHIR standards 

‘CareCommuncation’ 
and 

‘HospitalNotification’ 
Intro: Touchstone

Jan. Feb. March Apr. May June Aug. Sept. Oct. Nov. Dec.

First draft 

implementation plans 

and transition period. 

Milestones described.

Touchstone in 

operation

Supply / change of IT 

system shifts

2022
Workshop 

Evaluation 

Follow up

MedCom status 

and 

presentations as 

well as status 

from all 

participants 

Feedback & 

evaluation

1.0 release 

January

MedCom prepares proposals, rounds of 

dialogue with IT suppliers, regions, 

municipal groups, PL forum

Follow up

MedCom status and presentations as 

well as status from all participants 

Plan for certification

Release plan / technical impl.

Organizational impl.

Operating date

Discuss date phased out oioxml / 

edifact

Coordination 

meetings

Video meeting

Joint or bilateral

MedCom 

Steering group.

June 10

MedCom 

Steering group

September 8

MedCom 

Steering group

December 1

Dissemination and 

coordination meetings

Video meeting

Joint or bilateral

Transition period / solution 

determined and prepared

DRAFT

Video 

meetings

Video 

meetings

Video 

meetings



Roadmaps & agreements - data collection

We know a little about the regions' plans …… but we need to
Start the dialogue about specific roadmaps & implementation plans with all participant 

• The regions

• Health agreement and other agreements – let us know if you want MedCom as a part of the dialogue  

• The IT suppliers - including implementation plans for the municipalities and GP

• PL forum & KKR digitalization network

Send written inquiry around February 1, 2021
• Mail, video conference & telephone feedback February - bilateral

Suggestions for follow up video meetings
• May - June 2021 - jointly / regionally

• August - jointly / regionally

We may need different schedules
• How long will the transition period be?

• Different schedules per standard

• East & West Denmark and/or per region

• General practitioners / municipalities as frontrunners?

• MedCom will take contact

DRAFT



Thank you


